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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety

Precautions and Precautions for Safe Use in the manuals for the devices that are used in the

system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer

Manual No.

Model

Manual name

OMRON

1610-E1

Model CK3E-LIOO

Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON

W580-E1

Model NY5100-A0ICI0

Industrial PC Platform NY-series
IPC Programmable Multi-Axis
Controller Hardware User’s Manual

OMRON

Z365-E1

Model FH-1050/3050

FH-1OOO-OO)/3000-00)y/
LOOO-00), Fz5-e00(-00y/
1100(-00)/L3500(-00) Vision
System User’s Manual

OMRON

Z342-E1

Model FH-1050/3050

FH-1OO0O-O0O)y3000-00)y/
LOOO-0O0), Fzs5-e01(-0J0)y/
1100(-00)/L3500(-00) Vision
System User’s Manual
(Communications Settings)

DT

0014-E

Power PMAC User’'s Manual

DT

O015-E

Power PMAC Software Reference
Manual

DT

0O016-E

Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and 1/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESI files into the EC-Engineer, to easily allocate slave
process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.

Acontis
EC-Engineer

This computer software is used to configure the EtherCAT network and
each slave.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) It is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of July 2016.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property
damage.

/A WARNING

f C t. Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the OMRON Vision System FH
Series model FH-1050/FH-1050-1C0 or model FH-3050/FH-3050-101 (hereafter referred to
as the Slave) using OMRON Programmable Multi-Axis Controller model
CK3E-UOOO/NY510-ALOO (hereafter referred to as the Controller) and EtherCAT, as well
as for checking the connection.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices

The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Controller Model CK3E-DIDOL
OMRON Programmable Multi-Axis Controller Model NY510-ACICIC
Industrial Box PC
OMRON FH Sensor Controller Model FH-10O0/FH-1000-00
Model FH-30O0O0C/FH-3000O-010
OMRON 0.3 megapixel digital camera Model FZ-SC/S

0.3 megapixel compact digital camera
0.3 megapixel compact digital camera,
pen type

0.3 megapixel high-speed camera

0.3 megapixel high-speed CMOS camera
2 megapixel digital camera

2 megapixel high-speed CMOS camera
4 megapixel high-speed CMOS camera
5 megapixel digital camera

Intelligent camera

Intelligent compact camera

Auto-focus camera

Model FZ-SFC/SF
Model FZ-SPC/SP

Model FZ-SHC/SH

Model FH-SC/SM

Model FZ-SC2M/S2M

Model FH-SC02/SM02

Model FH-SC04/SM04

Model FZ-SC5M2/S5M2

Model FZ-SLC15/SLC100 Model
FZ-SQO010F/SQO50F/SQ100F/
SQ100N

Model FZ-SzZC15/SZC100

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as

examples of applicable devices to describe the procedures to connect the devices and check

their connections.
You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher

than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

Additional Information

This document describes the procedures to establish the network connections. It does not

provide information on operations, installations, wiring methods, device functionalities, or

device operations, which are not related to the connection procedures. For more information,

refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as

follows:

Model CK3E-OJOO0O Model EH-1050

Model FH-3050

Windows computer
Power PMAC IDE
Acontis EC-Engineer

Camera
| [P
£ % 5~ USB mouse
—=__ Ethernet EtherCAT ~
communications communications
Monitor
Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model CK3E-CI0000] ver. 2.2
Controller
Model FH-1050 Ver. 5.00
OMRON FH Sensor Controller Model EH-3050
OMRON Camera Model FZ-SLC15
OMRON Camera cable Model FZ-VS
OMRON Monitor (analog RGB monitor) Model FZ-M08
OMRON Monitor converter connector Model FH-VMRGB
- USB mouse -
DT Power PMAC IDE - Ver. 2.2
Acontis Acontis EC-Engineer - Ver. 2.4.3

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information

This document describes model CK3E-LICIC1C as an example. The same procedures can
apply to model NY5101-ACICIC.

©



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via
EtherCAT. The description assumes that the Controller and the Slave are set to factory

default.

I 6.1. Workflow

Take the following steps to operate the PDO communications via EtherCAT after connecting

the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup

v

6.2.1 Creation of a New Project

v

6.2.2 Initial Settings of the Controller

v

6.3 Installation of ESI Files

v

6.4 EtherCAT Communications Setup

v

6.4.1 Communications Setup for the EtherCAT Master

v

6.4.2 Distributed Clock Setup

v

6.4.3 PDO Map Settings

v

6.4.4 Creation of an EtherCAT Network Configuration
File

v

6.5 Controller Settings

v

6.5.1 EtherCAT Network Configuration Settings

v

6.5.2 EtherCAT Communications Check

v

6.5.3 EtherCAT Variables Settings

v

6.5.4 Writing the User Program

v

6.5.5 Project Data Transfer

10

Prepare the Controller settings.

Install the ESI file for the Slave into
Acontis EC-Engineer.

Set up EtherCAT communications.

Set up the Controller.



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.2.1. Creation of a New Project

1 Connect the Controller with the
computer via Ethernet cable.

2 Turn on the power to the
Controller.
3 Start Power PMAC IDE.

* |f the dialog for confirming
access rights appears upon
start-up, select starting of Power
PMAC IDE.

4 The Communication screen

appears. Specify the IP address & Delta Tau Data Systems Inc. Emrimnmen' S|
— e ————"—___ =
of the destination Controller and Communication | |

click Connect. D= 4| | B
P iddress 192.168.0.200 [=]
Port »
*
The IP address of the Protocol SSH
Controller is set to User root
. ., Pagzward 258889999
192.168.0.200" by default. fpply AllGontrals True
SelectDevice dtStartup True

* |f necessary, change the
Windows IP address to

“192.168.0.X". IPAddress
Set [P Address

Connect

’ Lazt Ses=ion ] [ Mo Device I

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

11



5 Power PMAC IDE starts, and is
online to the Controller.

o Pawer PMAC Sule (HTRHE)

Iﬂhmymmmmmumnu Window  belp
|t e 6 a8 [ 0 O o | Do

Watch: Onhnell921680.20055H] » 4 X

On
$¢0¢ Domand

* Any CPU
tus J Jog Ribbon | 4 Communication Setup _

HAROER(S): Bk v || i e 1

 FO5z 21 PowerPmac OERCRALELR.

2 - 0x

[ vua-=£
[ERm | PowerPmac] No Device:)
3 € Language
Ca Configuration
[ Docurmentation
3 Log
(23 PMAC Script Language

E-&-8 88

Communication Settings

“Fowerpmac (1 705,

| PowerPmac{No Device:) Project Proper -
EITE
| User Bufter 1 =]
8 PowerPMAL Communication Setup
Device Properties X
e e
Devicr Properties

6 From the File menu, select New

-
<+ Power PMAC Suite (Administrator)

then PrOj ect. Edit View Tools Delta Tau Window Help
MNew 4 Project... Ctrl+Shift+N
Open » | 0| File.. Cerl+N  fup _
I Close Project From Existing Code...
| 27| Close Soluti #
o) ose Solution Response “
H [ | Save Selected Ttems  Ctrl+S o
| 0233567 #3
Save Selected Items As... 025 #4
I @ | Save All Ctrl+Shift+5 _ #5
Export Template... 1] 29
| [@ | Page Setup...
| &j| Print... ctri+p P
H Recent Files » ’
i
| Recent Projects »
f Exit
7 Enter a pl'OjeCt name and T
: =
location, and select OK. o trom: P ke
FoserFTec Posa b Fmachsile maralld templite
Ofes Progect Tvoes
[Femeer PHaE
freee Joreccsaenn
Licmtn w| proen.
Foktontape: | [CTicrsien F treate drectory b ackusan {'jr




6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary

data in advance.

1 In the Terminal pane, type the $$$***

command to reset the Controller to File Edit View Project Build Debug Tools DeftaTau Window Help
- S H @ 1 - - - F Debug -

faCtory defaU|t Watch: Online[192.168.0.200:55H] ~ I ¥ || Position: Onli
Send g;mand Command Response a1

B SsSencCount 8505625 |
[l ECAT[0]Enable 1
D Slave_0_6071_0_Targettorque |stdin:3:2:err.. |

Terminal: Online[192.168.0.200:55H] >3 X pp_disable.
fiFRE
LA
dis=ab
clear

enabl

== i

2 Fromthe Tools menu, select System

‘Window  Halp

Setup to start System Setup. Ry ocn RS
d-0e s d e (EEErEN

B Termna g Postion [T .. Fiat

Winkch: Dl 192 100, 0 0004 RS

Oy | BB| TeskManager
Sand o d Curnrni %
| | Tune
r ECAT}|
1 . ooess...  Cli-+alt+
r Ecayy| Aktach ta Froce Cirl-+alt
[ [Ecam| i A0 nraraow..

Extmrnal Tooks.

Oplions, .,

PowerPMAC System Setup starts.

Gilohal Clack Sating

el T T p——e— PSP
okihed

Errme | FAAE [ —




3 From the File menu of PowerPMAC

System Setup, select New then
Setup.

PowerPMAC System Setup : Online[192.168.0.200:55H]

File | Database

-| New > Setup I
Add 3
Save Setup
Restore Setup

Specify Servo Frequency.

Select the Servo Frequency setting
from 4 KHz, 2 KHz, or 1 KHz.

* Servo Frequency is set to 1 kHz for
the example in this document.

Global Clock Settn

Phage Frequency 1.000 kHz

Servo Frequency (1000 =l kHz

Detected Servo Hardwars-PWM Frequency

5 Click the Accept button.

e B

Q@

v ol
Mo clock  PowerPMAC ww |

settings Walie
Servo Perod (msec) 1000 1000
FhaseOverServoPeriod 1000 1000

Ttems

HNo Master Gate detected and Mo

ETHERCAT opticn detected

PowerPMAC can be used asa PCusing | _
' software clock. (sys CPUTimerdntr = 1) On|

Accepting the clock issus save and 585

in the terminal window for changes o

take effect Check ‘sys ServeTime’ to

6 If you have changed the servo

frequency setting, type the SAVE
command in the Terminal pane of
Power PMAC IDE.

When complete, the “Save Complete
message appears in the Terminal

pane.

Terminal: Online[192.168.0.200:55H] !

dve

14



7 Click Communication Setup on the

toolbar to display the Device
Properties dialog box.

I File Edit View Debug Tools DeftaTau Window Help

Bl Edd Lo
B Terminal 4 Position I Watch [ Status [ Jog Ri
| Watch: cffine >0 X

han || Commurication Setup| _

En Cammand

On
™ Cuenard
W 5y SencCount

Pi001

[PhAddress
Furtbhamtn
Pratecol
User

B Do Propetios S = !
| | ]
@

0O Device "

1P Adrms

3ot TP A

\‘ BHROERS):

8 In the Device Properties dialog box,

select No Device for IP Address, then 8 veoe ropers SN ==

click the Apply button. B | [t ]| Lo ]
B Device -

This operation sets the Controller to E:;ijb E‘

the offline state. Ip:dd o s S
Set IP Address

o] The Controller restarts.
The servo frequency that has been
set is reflected.
10 Wait until the startup process of the

Controller is complete. Then click

Communication Setup on the toolbar [2 pevice propertes =)

to display the Device Properties dialog LoTest | ey

box.

In the Device Properties dialog box, =

return the IP Address to the previous
setting, then click the Apply button.

This operation sets the Controller to
the online state.

Protocal
Uzer

IP Address
Set IP Address

4 L |

15



I 6.3. Installation of ESI Files
Install the ESI file for the Slave into Acontis EC-Engineer.

M Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 Start EC-Engineer. .
£ Power PMAC IDE

ﬂl

- | Windows Explorer >

>
T Pant 13

a0
L5 5

¥ All Programs

|Search programs and files 2 |

16



2 From the File menu of EC-Engineer, W

select ESI Manager.

The ESI Manager appears.

ZICW View Network Settings Help
% MNew Ctrl+N
= Open Ctrl+0
KH save Cirl+S _
K save As
Print

Vet TS S -
ESI Manager

W
= Recent Projects »

Exit Alt+F4

Example of the ESI Manager

= Esl Manager [ [E=E =)

ESI Files
Select an ESI file which should be deleted or exported or &dd naw ES1 files.
£ Baumueter Nuemberg GrmbH
B Becknaff Automation GmbH & Co. K5

€@ Copiey Cantrols Comp

B3 OMRGN Corporation

.
»
1 3

| » L e
-
Bouns VIPA Genbed
»

¥ vasuawa Dedtric Conporatian

Number of ESI files: 79
l Number of devices: 1630 I

Add File Add Folder Close

3 Confirm that Omron FH-xxxx-xx.xml
is registered in the ESI file list of ESI
Manager.

If it is not yet registered, click Add
File and register Omron
FH-xxxx-xx.xml.

== =)

([ ESt Manager = =

ESI Files
Select an E51 file which should be deleted or axported or add new ESI files.

| | b G Covley Controis Com.

b Omran G-Digital 10 smi

Number of devices: 1925 |

Add File Add Foider Close

-
= Add ESI File

LEI®)

|\ « Documents b SystemEsiFiles

Ll Recent P
= Recent Haces 2 Omron FH-ococicc

m

=3 Libraries =] Omron FZML-XXX-ECT
%) Documents rmron GRTL-ECT_Ver2 0
o Music =] Omron GX-Analog 10
] Pictures 2] Omron GX-Digital 10
B video: <] Omron GX-Digital 10-T
B Cornrnser ~ | 0 ] v

+ |EStFiles (*xmi) -

File name:  Omron FH-xo00c-10c

Organize » New folder =~ 0 @
i Favorites Documents library P o Folder ~

B Desktop SystemEsiiles

|8 Downloads o - a

m

==

4 Click Close to close the ESI
Manager.

17



I 6.4. EtherCAT Communications Setup

Set up EtherCAT communications.

M Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet

cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

2 Display Start Page of
EC-Engineer, and select
EtherCAT Master Unit (Class
A) from Add Master Unit.

e yiew

= EC-Engineer [--]

k. Gettings  Help

4 Configuration Mode: IS W Diagniosis Mode

EC = Engineer

Getting Started

|| Classic view | Flat View | Topology View

3 Class-A Master is added to the
Project Explorer.

General
Uk Hame Clnss. A saaster

Cyde Time [us) 1000
‘Source MAC address

18



4 In the Master page, specify a
communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

= EC-Engineer 1]

[£e wew petwork  gemngs e

B Dragnosis Mode

Marster

General

l Cyde Time [us) 1000 I

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

5 In the Master page, enter the IP
address of the Controller in IP
Address, and click the Select
button to apply the setting.

* Default IP address
“192.168.0.200" is specified in
this example.

* Do not select Slaves
connected to local system as
it is not used.

Device Editor
Master

General
Unit Name Class-A Magter
Cyehe Time [us] 1000

Source MAC address

Slaves connectied to local system
Network Adapter O—72iL TUFHEEE ( Intel(R) Ethernet Connection 1217-LM )

Selact
Slaves connected to remote system
I 1P Address 192.168. 0 .ztol
v Geini
Master-Instance o Salect

6 Right-click on Class-A Master in
the Project Explorer, and select
Scan EtherCAT Network from
the menu.

= EC-Engineer [--]

Network

File  View Settings  Help

£ Configuration Mode ™|

Project Explorer Device Editor
. Class-A Master Master
*.. Scan EtherCAT Network

General

B Diagnosis Mode

&F Append Slave

Unit Name
#® Remove Master-Unit Cycle Time

Source MAC
: Slaves conn¢
3 Import Slaves from ENI File N

# Change Master Unit

Make sure that the slave is
displayed in the Project Explorer.

= EC-Engineer [--]

|FI|E WView  Network  Settings Help

i, Configuration Mode JFSTEST-R 300!

- . Class-A Master

:I I Slave_1001 [FH-3050] (1001) I

19



6.4.2. Distributed Clock Setup

1 Setting Distributed Clocks (DC)
for Master

In the Project Explorer, select
Class-A Master to display the
Distributed Clocks tab page.

Clawseds Wt Maser | Process Dnta brage | Variables | Asusaced Opices | Slawe b
L ‘Sune_L001 [FH- 3080 (1001
Clock Adjustment

@ Lhatter S1ult {tharCAT bsttor Fime controded by Rebance Clock)
Bt Snim (Refpsence Clock eontsstied by EtherCAT Master Time)
Options
Comnasans Erapagstan Campensiton
fyme Window Monanng

Show 5251 Sptern T

* |f the Distributed Clocks tab does not appear, select View
then the Expert Mode check box.

= EC-Engineer [--]

File Network  Setting

vy Messages
Short Info

Proje
Expert Mode

-

Refresh F5

2 Select Master Shift (EtherCAT
Master Time controlled by
Reference Clock).

Clrwae Mt Master | Process Dus Irage | Vansbles | Asvasced Options | Slawe ta Slive | Distribwtid Dok | Mutnple Tases
I e 1004 FP-DOSEY (32020

Refesence Clock
e ‘Sune 001 [FH-3080) 1001

Clock Adjustment
B Lhaiter Soult {[tharAT bsttor Time controbed by Rebance Clock)

But S (Rebpsence Clock conteotied by EtherCAT Master Time)

Options
Comnasans Erapagstan Campensiton
fyme Window Monanng
Shom 453t Syvtern Tns

3 Setting Distributed Clock (DC)

for the Slave

In the Project Explorer, select
the target slave to display the
Distributed Clocks tab page.

== EC-Engnger [--]

[Fle view motwok sengs _rew

£ Conbguraticn Mode JEWIZSERT2NY I, Diagnosis Mode
| ] ! Modules | FDO Magping | Variabies | Advonced Ecmmnm CoE Object-Dictionary

Distributed Cloek
Operation Mode DC Syned
Sy Unit Cyde (us) 1000
verwrito Mode ¥
] Syne Units
¥ Sync uan 0
Cyee Trme
@ Sync Unit Cyde x1 1000 us
User defined 1000
Shift Time {us) 500

20



4 Select the Overwrite Mode
check box and specify Shift
Time.

Class-A Master
+ | @siave_1001 [FH-3050] {1001)

Ganeral | Modules | PO Mapping | Variables | Advenced Options | Distriouted Clock | Init Commands | CoE Cijject-Dictionary

Distributed Clock

) Sync Unks

) Syne Unit 0

Cycla Time

User defined

[ =1

500

Shifk Time {us)

Correspondence between the servo frequencies of
the Controller and Shift Time values is as follows:

4 kHz : 125 us

2 kHz : 250 us

1 kHz : 500 us

6.4.3. PDO Map Settings

1 In the Project Explorer, select the
target slave to display the PDO
Mapping tab page.

+ | i T (55 '

Setting PDO mapping (Inputs)

Check the Inputs field to make
sure that the 512th transmit PDO
Mapping Ox1BFF check box is
not selected.

Inputs
- 1 trengmit PDO Mppging OeigFF *
Harre
Svinas Errer Soatus Qe 00201 8
- Module 1 [Resst Dada Format 0). 1t trarsmi PDO Haopang Owland

M e [t Largth

21



3 Setting PDO mapping (Outputs)

You do not need to configure the
settings as there are no settings
that can be changed.

Outputs

- Madyle § (Resui Data Forenat I, 19t resebes PDO Magping CxiEdd =

Hame Ltes Bt Lergthi

22




6.4.4. Creation of an EtherCAT Network Configuration File

1 Click Export ENI on the upper
part of the EC-Engineer page.

= EC-Engineer [--]

File View MNetwork Settings Help

= Export ENI

“{ Configuration Mode

BB, Diagnosis Mode

2 Enter a file name, and then click
Save to create an EtherCAT
network configuration file.

= Export EtherCAT-Network-Information (ENI) File
—

Search tmp

mv .+ Computer ¢ Local Disk (C) » tmp

Organize = MNew folder
&, Local Disk (C5)  »

. DeltaTau

MName Date modified

)i inetpub Mo items match your search.
. Intel

. OE-Downloade—,
. Omren
./ Perflogs

.. Program Files

. Program Files

L tmp

-~ 4 .

Type

|
I File name: m I

Shve as type: lEtherCAT-Network-Information (EMI) Files (*xml}

# Hide Folders

[=

Cancel

I 6.5. Controller Settings

6.5.1. EtherCAT Network Configuration Settings

1 From the Tools menu of Power gy et e

PMAC IDE, select System M

. 3 Hardmirn Dispress: —_
Setup to display System 3 T EtherCAT.
EtherCAT Licanse Status: ExherCAT 10 Deices Licenss Only
SEtu p . EtherCAT Master ype: ACONTIS
Browse i a0 e [Browse| | Downicad ENitie
PowerPMAC System Setup ; Ondned 192, 168.0,200:58H] T B i

Click Browse, and load the
EtherCAT network configuration

| File Database

4 Powes PMAC (152,168 0200
T Hardmarn Dispross:

EtherCAT. ~

; . i o ot
flle CreatEd n 644 Crea‘tlon Of EXherCAT License Status: EtherCAT I0 Davices Liconss Only
an EtherCAT Network ﬁ"ﬁ“ Aconms
Configuration File.
Click Download ENI file to

3 EtherCAT.

download the EtherCAT
network configuration to the
Controller.

EtherCAT License Status: EtherCAT IO Devices License Only

EtherCAT Master type: ACONTIS

Browse to eni file

6.5.2. EtherCAT Communications Check
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Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

Terminal: Online[192.168.0.200:55H]

ECAT[0].Enable=1

2 In the Terminal or Watch pane, Watch: Online[192.168.0.200:55H] TR
make sure that the Send g;mand Command T
ECAT[0].Enable value turns to 1. P T EIE4S

ECATI[O].Enable 1
* The OP mode is entered and . ECATIO]. Error s0
EtherCAT communications are L_J
established.

3 After making sure that correct Watch: Online[192.168,0,200:55H] > 1 X
communications are available, run Send g;mand Command Response
the ECAT[0].Enable=0 command s ——
from the Terminal pane to stop ECAT[OL.Enable 1
EtherCAT communications. . ECAT[0].Error 50

L]
TR

| Terminal: Onhine[192.168.0.200:55H]

ECAT[0] Enable=0

4 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value turns to O.

Watch: Online[192 168.0.200:55H] > 1 X
Send g;mand Command Response
Swe SenaoConnt 1252814
ECAT[0].Enable 0
ECATIO0].Error 50




6.5.3. EtherCAT Variables Settings

1 In the System Setup page,

right-click on
Master[0].Deactivated to
display the pop-up menu, and
select Export EtherCAT
Variables.

PowerPMAC System Setup : Online[192.168.0.200:55H]

File Database

5 PowerPMAG {192.168.0.201

rt EtherCAT Variables

EterCAT.

TITET G CICETTS e TS LtI]ErCAT |0 Device

EtherCAT Master type: ACONTIS

Enter a name for the EtherCAT
variable definition file for user
programs into the root of the
project folder.

-
. Save As

@O= « My Documents b Suite » » - [ 49 [I[ 5=
- - ——

&, Local Disk (C1)

Organize v New folder
L 4 Name ° Date modified Type Size
B Desktop ! Bin /8/2016842PM  File folder
8 Downloads CLanguage 7/8/2016842PM  File folder
] Recent Places ! Configuration 7/8/2016842PM  File folder
Documentation 7/8/2016842PM  File folder
= Libraries L Log 7/8/2016842PM  File folder
[ Documents | PMAC Seript Language 7/8/2016842PM  File folder
& Music
&) Pictures
BE videos
1% Computer B

File name: | ECAT Veriabled

Save a5 type: | ppmac header files (*.pmh)

5

= Hide Folders

The created EtherCAT variable
definition file is added to under
Global Includes of PMAC
Script Language in Solution
Explorer.

Position: Online[19.. v & X

Velocity: Online[192.

~ R x| |Following Error: Onll

nu

ecat_variables.pmh

. ecat variables.|

#define Slave_0_3220_1_OutputBit00
#define Slave 0_3220_2 CutputBit0l
#define Slave 0_3220_3_OutpurBit02
#define Slave_0_3220_4_OutputBit03
#define Slave 0_3220_5_CutputBic04
#define Slave_0_3220_6_OutputBit05
#define Slave 0_3220_7_CutputBit0s

ECAT[0] .IO[O] .Data
ECAT[0].IO[1].Data
ECAT[0] .IO[2].Data
ECAT[0] .IO[3].Data
ECAT[0] .IO[4] .Data
ECAT[0] .IO[5].Data
ECAT[0] .IO[6] .Data

|

~ 1 x| Selution Explorer - Solution".. ~ & X

[ Solution 'PowerPmac?' (L project)
- ] PowerPmac2(192.168.0.200:x¢
£3 C Language
[ Configuration
[ Decumentation
g Log
) [ PMAC Script Language
£ [ Global Includes

[Eil =cat varisbles.pmh)

[ Kinematic Routines
3 Libraries

3 Motion Programs
3 PLC Programs

b BB

e T—— v
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6.5.4. Writing the User Program
Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s
Manual and Power PMAC Software Reference Manual for details.

1 In the Solution Explorer pane,
open Project name — PMAC
Script Language — PLC
Programs —plcl.plc.

F 0 Terminal
Exaio - Skt

PE_custosm_iaaetpl
o pp_dsabiens
] pp_ing_disabletd
5] pp_inc_startuptst
pp tancly
5] pp_startupcta
7 = Documentation
d Loy
Loy PMAC Sonpt Lengusge

myecatolp ' ecatactivatelcly . MA510080 | 20051008 pmb s

% Globed Inchades
MHSLOHE pmby
gekal defindioni.prh

A Kinematic Routines

Propertiet . B
" ||| ecatscthatedloly Fie Properties
w41

2 In the programming area of the
plcl.plc tab page, write a program
as shown on the right.

open plc 1
while(sys.ecatMasterReady==0){};

ECAT[O].Enable = 1;
This sample program repeats the

measurement every second. P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){};
* In this example, PDO mapping Slave_0_7000_2_Trigger = 1;
is assumed to be the default
setting. If you want to change P1000 = Sys.Time + 1;
PDO mapping, rewrite the while(P1000 > Sys.Time){};
“Slave_0...." description. P1001 = Slave_0_6000_6_TriggerAck;

P1000 = Sys.Time + 3;
while(P1000 > Sys.Time){};

Slave_0_7000_2_ Trigger = 0;
P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){};

P1001 = Slave_0_6000_6_TriggerAck;

close

26



3 Setting the start of the user
program ndaw . Help

thug » Any CPU v | [ 1800 - | g = | Terminal

Sahstion Exploter - Sohtion ' -

In the Solution Explorer pane,

= Inchade
. 20150028k
open Project name — Fp.prdl
Lbwmries
¥ j Reaitime Eoutires

Configuration — pp_disable.txt.

o Configusation

pr.disabletxt | myecatcf| ecetcthatelcly | 20050080 W

ecatactivatel chy
] /FELll all the motora (This opoiar 1

A fRBsET
disable plec 90..131 FifDisable all Script PLO»

clear sil buffers

pp_savecly
8] pp_stertupin
& [ Documentation

Jl Leg

pp disable twt File Propeties
sl

2 x

In the programming area of the
pp_disable.txt tab page, add the enable plc 1;
program shown on the right to the
last line.

IN

The pp_disable.txt program is
automatically executed when the
Controller starts.

This example program runs the
PLC1 script.

6.5.5. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred
from Power PMAC IDE, devices or the machine may perform unexpected
operations.

Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications
with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.
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1 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value is 0.

If the value is 1, run the
ECAT[0].Enable=0 command
from the Terminal pane to stop
EtherCAT communications.

- Power PMAC Suite (Administrator)

File Edit View Project Build Debug Tools DeltaTau V
TR = - 10 S - W [ O R o
hoar | EEE|E 2O & B

@ Terminal 4 Position [Z] Watch |8 Status @ Jog Ribbon | < ¢

Watch: Online(192.168.0.200:55H] ~ 1 x
Send o Command Response
1 | |ECATIOlEnable 0

#1- Make sure that ECAT[0].Enable=0

Terminal Online[192.168.0.200:55H]

2 Downloading a project Solution Explorer - Powe... v 11 X
=
. . . . (oA Solution 'PowerPmac_ECC201+S
Right-click the project name in M| PowerPmac_ECC201 +Safe
the Solution Explorer pane on 7+ 5 CLanguage ] | Build
) - [ Background H Claan
the upper right of the IDE +- 3 CPLCs
. + 4 Include Debug
screen, and select Build and L :
| Libraries Build and Download All Pregrams
Download All Programs to run . @& [ Realtime Rt Download All Programs
. +- [ Configuration _
the build and download. + 3 Documentation Map PMAC Variables
+ £4 Log Add Macro Project
#- £ PMAC Script Lan % | cut
* | Remove
Unload Project
1 LilJ i | Properties
Properties >~ I'X ] r
3 Make sure that there are no

errors in the Output tab page.

* |If the transfer fails, check
details of the error in the Output
tab page.

If the error is a program error,
you must review the program.

If the error is related to
EtherCAT settings, return to
System Setup and check
whether there are any incorrect
settings.
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4 The program starts running

when it has been downloaded Terminal: Online[192.168.0.200:55H] ~ 0 X
successfully.

EtherCAT communications are
in the OP state. Make sure that
measurement is carried out.

|er|ab|e plc1

* [f measurement is not carried
out, check that the
ECATI[0].Enable value is 1 in the
Terminal or Watch pane.

If the value is 0, run the following
command from the Terminal
pane.

enable plc 1

After you have confirmed an Terminal: Online[152.168.0.200:55H] ~ 1 X
appropriate operation, save the |SEiSZES

project to the Controller.

ave
Run the save command from the 's—l
Terminal pane.

* The transferred project is not
yet saved to the Controller at
this stage.

If you turn OFF the power to the
Controller, the transferred
project will be discarded.
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7. Appendix Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File o pn_projh
----- 1 Libraries
[+ [ Realtme Routines
Create a Configuration File to (SRR Configuratien
..... Add »
save parameters you have || | . Ei ,
hanged in System Setup tothe || = [ po_ay | TP
¢ a_nge In system setup tothe 1 3 Upload Config Files
prOjECt. ; Download Config Files
..... Generate Configuration File
Y . . PRV | I S 3 -
Right-click Configuration in the &1 E Documentation
Solution Explorer pane, and e PR e
select Generate Configuration
File.

A Configuration File is added to
Configuration.

2 Right-click on the Configuration - Configurat
7 Configuration
File, and from the menu, select () PEPPRNTRINCE=

m

. . — [Z] 3| Open
Check To Download Config File .. — Open With...
to include it in files to be j 5| View Code
downloaded. = Exclude From Project
= )( Delete
) :} Rename
i Check To Downlead Config File
Prope
.| iz | Properties
Lalgtally
3 Saving a Project 4 Power PMAC Suite
Edit View
. MNew
In the File menu, run Save All to open
save the project on the computer. Add

Close
1 | Close Solution
Upload Projec!

|l | Save uPowerP

Save uPowerF

I,j Save All I
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

2 In the Terminal pane, type the
$$$*** command to reset the
Controller settings to factory
default.

Terminal: Online[192.168.0.200:55H]

LG

3 In the File menu, Click Open —

< Power PMAC Suite (Administrator)

PI’O]ECt/SOlU'[IOI’] to Ioad the Edit View Tools Delta Tau Window Help
. tth t d New 3 t - & |Del:t;| vHAm CPU - || 2
prOJeC a you saved. Qpen P | &} Project/Solution... Ctrl+Shift+0 -
Close & | File... Ctrl+0 o X' || velocity:
Responze : =
= b 3 =
g g #4
@ | Save Al Ctrl+5hift+5 _ #5
l Export Template 3 i =
Page Se
Prir +P
Recent Files 3
Recent Projects b
Exit
4 From the TOOIS menu Of Power PowerPMAC System Setup : Ondnid 192.168.0,200:55H] i
File Database
PMAC IDE, select System Setup —
] EtherCAT. ™
to display System Setup. P T

EtherCAT Master type: ACONTIS

Browse to eni fils Browse Duwniad ENI e

5 Click Browse, and load the ENI

configuration file that you created in

6.4.4 Creation of an EtherCAT
Network Configuration File.

—
EtherCAT. ™

EtherCAT License Status: EtherCAT IO Devices License Only

EtherCAT Master type: ACONTIS

Browse to eni file

| Download ENI file |

6 Click Download ENI file to
download the EtherCAT network
configuration to the Controller.

EtherCAT. ™

EtherCAT License Status: EtherCAT IO Devices License Only

EtherCAT Master type: ACONTIS

Browse to eni file

B{m
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7 Right-click Configuration in the S —

=]

Solution Explorer pane, and select
. . = [ Include -
Download Config Files to L[] 20160204.h
download the file to the Controller. ~ L] pp_projh
----- [ Libraries

+- [ Realtime Reutines
=M= Configuration

----- || ecatactiva Add »
- | myecat.cf] -

..... pp_custon i | Properties

..... || pp_custon Upload Config Files

""" =] pp_disable Download Config Files

""" ? pp_inc_dis Generate Configuration File
----- =| pp_inc_stz.

----- | pp_save.cfg

J

----- =] pp_startup.bxt -

8 Right-click the project name in the | Selution Explorer - Powe... » I X

Solution Explorer pane, and select | =
_: Solution 'PowerPmac_ECC201+5

Build and Download All M| PowerPmac_ECC201+Safe
Programs to run the build and 7 & Clanguage | {5 Build
- 3 Background Clean
download. - [ CPLCs
Debug »

Build and Download All Programs

Download All Pregrams

When the download process is -
I | Configuration
complete, make sure that there are - Ca Documentation

no errors in the Output tab page. #- [ Log
i [ PMAC Seript Lan | cut

Map PMAC Variables
Add Macre Project

X | Remove

Unload Project

4 LI} i= | Properties
Properties ~ I'X l r
9 Stopping a program Terminal: Online[192.168.0.200:55H] -~ 0 X%

If a program is running, execute the I
following command from the
Terminal pane to stop the program.
disable plc 1

|u:|isable ple 1

ECAT[O].Enable=0 Terminal: Online[192.168.0.200:55H] ~ 1 X

”ECAT[D].EnabIe=D




10 Saving the downloaded settings
and programs

After the download process is
complete and you make sure that
there are no errors in the Output
tab page, run the save command
from the Terminal pane.

* The save command stores the
downloaded project in the
Controller. This operation saves the
settings to be executed
automatically when the power to
the Controller is turned on.

Terminal: Online[192.168.0.200:55H]

Save Complete

|SE'-J'E

11 Restarting after download

Run the following command from
the Terminal pane to restart the
Controller with the downloaded
project.

$$$

Terminal: Online[192.168.0.200:55H]

||555
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8. Appendix Troubleshooting

8.1. Factors Causing EtherCAT Communications To Be Unavailable, and
Corrective Actions
Description Factor Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECAT[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is setto a
value other than 0.

Check the ECAT]O].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode
of Acontis EC-Engineer.

B System Setup of Power PMAC IDE
You can check the status of the EtherCAT master and slaves in the System Setup page of Power

File  Database

549 PowerPMAC (192.168.0.200)
¢ s Hardware Diagnosis
4 Motors

YY) ctcr{0] Activated

—
EtherCAT.

EtherCAT License Status: Mo License

EtherCAT Master type: ACONTIS

C\U=sers\OMRON_IPC_1\Desktopleni.xm!

[Browse| [ Download ENIfile
STave status
ECAT[®].5laveCount=2 B Mo Status Emor  Description
ECAT[@].TxTime=3
ECAT[®].RxTime=1 0 o] Mo Slave_1001 [GX0D1611]
BERE L= D e 1 oP No | Slave_1002 [GX-MD3218]

B Diagnosis Mode of Acontis EC-Engineer
You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineer.

i B EC-Engineer [__]- _\E@lﬂﬂ

|| File

View

Network

#. Configuration Made

Project Explorer

Settings

m

- @ Class-A Master <connacted>

Help

[ Diagnosis Mode

Device Editor
General |'\-"ar|'ables || ESC Register ” EEPROM || Extended Diagnosis " DC Diagnosis ” CoE Q[4][]

| o Slave 1001 [GX-0D1611] (1001) |
@ Slave 1002 [GX-MD3218] (1002}

State Machine

Current State |0p
Requested State |0p
Init
Change State Pre-Op Safe-Op
Error State
Current No error

35



Select Network then Network Mismatch Analyzer from the menu to verify the network configuration.

= Network Mismatch Analyzer @Elﬂ

List of slaves

Please, compare the configured slaves with the connected slaves. If something is red, you have a
netwaork configuration mismatch!

Name Configured Slave Revision Alias | Network Slave Revision Alias

Slave_002 [R88 | R88D-KNO1L-ECT [2] 0x00020001 O REBD-KNO1L-ECT [2] | 0x00020001 | 1

Slave_003 [RE8 | RB3D-KNO1L-ECT [3] | 0x00020001 | O

Close

8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,
and system.
To display the Status page, click Status on the toolbar.

B Global Status
You can check system errors such as the WDT error.

Status: Online[192.168.0.
Motor Status] Coordinate Status MACRO Status ] ECAT Status ]
Glebal Status
Description Status Description Status
Abortall False HWChangeErr False
BufSizeErr False MoClocks False
ConfigloadErr False ProjectLoadErr False
Default False PwrOnFault False
FileConfigErr False WD TFault MoFault
Flash5izeErr False
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Bl Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Coordinate Status] Global Statusl MACRO Status l ECAT Status ]
Motor 0 = ® Motor not activated

| Description Status Description Status
_ False IZtFauIt. i:alse
AmpFault False InPos False
AmpWarn False LimitStop False
AuxFault False MinusLimit False
BIDir Plus PhaseFound False
BlockRequest False PlusLimit False
ClosedLoop False SoftLimit False
Csolve False SoftLimitDir Plus
DacLimit False SoftMinusLimit False
DesVelZero False SoftPlusLimit False
Encloss False SpindleMotor False
FeFatal False TraceCount 0

| FeWarn False TriggerMove False

| GantryHomed False TriggerMotFound False
HomeComplete False TriggerSpeedsel MaxSpeed
HomelnProgress False

B Coordinate Status

You can check deviation errors, limit errors and other states of the coordinate system.

Status: Onling[192.

SSH]

Motor Statu CDDn:ImateStatu] Global Status] MACRO Status l ECAT Status ]
Coordinate System 0 =
Description Status Description Status it
|AddedDwelbis IS LinToPviBuf False
AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookfheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LockAheadReCalc False
BufferWarn 0 LockAheadStop False
CC3Active False LockAheadWrap False =
CCAddedArc False MinusLimnit False i
CCMode Off MovelMode LineCircle
CCMoveType Dwell PlusLimit False
|| CCOffReq False Proghctive False
| ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegMove Off
Encloss False SegMovelccel False
EndDelayActive False SegMoveDecel False B
ErrorStatus MoError SegStopReq False
FeedHeld Off SharpCornerstop False
FeFatal False SoftMinusLimit False
u‘-’am False SoftPlusLimit False
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9. Appendix ECAT]Ji] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT
controllers.

Element name Description Change
ECATI[i].Enable Enabling the EtherCAT 0: Disable, 1: Enable
network (2 and 3 are not supported.)
ECATIi].LPIO[K] Elements of low priority Not supported
I/O module
ECATIi].Slave[j] Slave elements Not supported
ECAT]Ji].Error Error code of enabling $ 9811000C: Invalid network
EtherCAT network configuration
$ 9811002E: Disconnected network
connection
ECAT]Ii].LinkUp Status data structure Not supported

ECAT[i].LPDomainOutputState | elements
ECAT[i].LPDomainState
ECAT[i].LPRxTime

ECAT[i].LPTxTime

ECAT[i].MasterStat
ECAT[i].RTDomainOutputState
ECATIi].RTDomainState
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